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Year 2014 

Release 2014.14.01 / May 

We have devoted this release to making enhancements and corrections to the ProSystem fx

New Enhancements 

 Practice Management Report Writer. 
Included in this release are 50 new report templates that can be saved and used as designed or may be customized for your firm.  
Included in the Report Writer are 106 new fields as well as a new report type for creating additional reports for Forecast Hours.  

Report Writer:  Report Templates 
50 new report templates have been added to the Report Writer.  There are templates for every report type and we hope you find it 
much easier to start with a report template instead of starting from scratch using a report type.  Report type functionality is still 
available. 

• Click on the report template and click 

To create a report using a report template: 

Save As
• You will be prompted for your firm report name.  

.   

• Save your report name. 
• The report is created as a firm report and is available immediately for any edits that you may want to make to customize 

the report for your firm. 

Report Writer:  Redesigned Navigation Bar 

The Report Writer Navigation Bar has been re-organized.  

 

At the top of the navigation bar you will find your firm reports in folders listed in blue and organized by the report type. 

My Reports List 

 

The new report template folders are listed under the folder “Available Report Templates” in black and organized by the report 
type. 

Available Report Templates 

Report Writer:  Report Template Booklet 

To review the new report templates use the hot link available at the bottom of the Navigation Bar for the Report Template Booklet

Report Writer:  New Fields 

.  
The booklet contains a snapshot of each report template, a list of key report writer elements for each report, an appendix with 
instructions and tips for creating and customizing reports, and an appendix that compares report templates with the same report type, 
side by side. 

106 additional fields have been added to the various report types to expand the Report Writer capabilities. 

Report Writer:  New Report Type 

A new report type, Employee Forecast, has been added with 39 available fields to increase the reporting capabilities of the Forecast 
Hours feature that was introduced in the ProSystem fx

Other Report Writer Enhancements 

 Practice Management 2013.13.01 release. 

 Added a blank line between subtotaled rows when printing reports with the detail level at ‘Show Detail or at ‘No Detail’ 
 On MTD/YTD report types, the YTD date range now displays the From and To dates 
 New splash screen which gives a brief overview of “How To” use the report writer 
 In customizing a report, the tab for selecting and editing columns now has a white background color to help notice at a glance 

when your column selections have gone over the available width and forced an additional row.  The second row is highlighted in 
gray and stands out against the white background. 

 Ability to change the font (type and size)  
 Page break can now be selected without selecting to sub-total at all detail levels for fields selected to group 
 When customizing a report, the ‘Remaining space for next column’  displays to assist with report customization 
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Other Enhancements 

 Added a new security option for the Employee Time Analysis Report. This gives you the option to view the cost section of the 
report. 

Getting Started with this Release 

Before Updating 
If your firm has custom or non-standard indexes on client, employee or project related tables that reference name or address fields, you 
will need to remove these indexes prior to applying the 2014.14.01 update. Once the database has been updated, the custom or non-
standard indexes can be added back

Report Writer 

.  The Practice Management Best Practice recommendation is to create a backup copy of the 
database PRIOR to applying the update. 

To take advantage of the new Report Writer report templates and fields, we recommend that you print the Report Template Booklet 
from the Report Writer Navigation Bar. 

 Review the snapshot of all the new report templates. 
 Review the How To and Tips Appendix 

Corrections 

Report Writer 
 Page breaks and subtotals are invoked when selected. 
 Page orientation selected when customizing a report carries forward to the Run Report option.  Additionally, page orientations 

saved from Run Report that differ from that saved in Customize Report are now honored. 
 Invoice and check numbers fields no longer allow for a subtotal during report customization. 
 Total Width on Row now calculated correctly inclusive of space between columns and of added lead space. 
 MTD YTD reports now display and calculate the correct YTD range. 
 In the report header, the date ranges now always print on a separate line. 
 Double underlines for grand totals are aligned correctly for reports where a column has been selected as an ‘End Row’ or the 

number of columns exceeds the maximum width for the row. 
 Reports with realization, effective rate, or ratio fields now calculate correctly with use of the No Detail preference. 
 Subtotals may be applied to non-sequential sort fields for all detail preferences as long as field is selected for grouping. 
 Use of the Between or Not Between filters for an Employee Banked Hours type report no longer generates an error. 
 Data from non-custom Yes/No fields are now correctly presented as Yes/No instead of 1/0. 
 YTD Total cost has been added to the MTD/YTD Employee Billing report type. 

Sales Tax User Entry 

 The Canadian Province Tax Rate can now be entered 3 places to the right of the decimal. All four places to the right of the 
decimal point now display in the Sales Tax tab's grid. 

Project Management 

 Unrolled projects with the same due date and type (but with unique descriptions) for the same client are no longer excluded from 
the "Show only projects not already rolled" option. 

Administration/Time Exception Report 
 When "Paid Time Off Employee Hours" is selected and "Include Inactive Employees" is not selected, inactive employees no longer 

display in the PTO section of the report.  
 When "Paid Time Off Employee Hours" is selected and "All Employees" is selected, all employees are included in the PTO section 

of the report, not just those who have exceeded their allowance. 
 When more than one level is selected (for example, Office/Department/Employee Name rather than Office/Employee Name), 

the report now displays the correct page and/or column headers for the PTO section of the report. 

Administration/Employees 

 If you delete and replace an employee, the report queues are now properly updated. 
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2013 Extension Forms / February 

Extension forms are now available for Tax Year 2013. This patch is only needed if you print extension forms from ProSystem fx Practice 
Management. 
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Year 2013 

Release 2013.13.01 / May 

Forecast Employee Hours 

My Week Forecast is now available on the Employee Dashboard to provide employees the ability to enter anticipated work hours for a 
week in advance. 

On the My Week Forecast tab of the Dashboard, enter the hours that you plan to work on clients for the upcoming week. The forecast 
grid provides a summary of the assignable hours and the forecast hours to see employee available hours for firm load balancing of work. 

Select the client from the client lookup. The client is a required field. 
 
Select the client project from the lookup if appropriate. 
 
The selection of the project is optional. If you select a project, the header on the bottom pane will display the due date, status 
and most recent milestone date. If detail tasks have been set up for the project the information for those tasks displays in the 
grid. This may be helpful, for example, if you are working on a 1040 project and want to check the budgeted hours associated 
with the task or want to see everyone associated with the project. 
 
Click the My Schedule button if enabled. Note also that if you have actually been scheduled for a task within the selected week 
the My  
 
Schedule button to the right of the project field will be enabled and you can view your scheduled detail tasks including hours for 
the forecast week as well as total hours for the detail task. 
 
Enter hours. You have been provided research if you are working on a client project but you are not required to enter the number 
of hours that have been scheduled or budgeted. Enter the number of hours you anticipate working on the selected client. 
 
Enter a reference. You have the opportunity to include a reference about the type of work without being required to enter a 
service code. 
 
Set My Hours. In addition there is an option to set your assignable hours for the week with security privileges. This provides better 
efficiencies to follow the constant changes to employee schedules. Implementation will depend on the security privileges for this 
option granted by the firm.  

 

Week At A Glance 

The Week At A Glance tab on the Firm Dashboard provides the ability to view anticipated client work hours for a week in advance 
by client management staff position. 
 
Select the new Week At A Glance tab from the Firm Dashboard and the calendar will display a week highlighted by default. You 
may override the selected week by clicking on any day on the calendar. This will also select the work week that contains that day. 
 
Any clients that you manage in the selected position when accessing the Firm Dashboard display if hours have been forecasted 
for the week highlighted on the calendar. The client, the client project, due date (if a project is used), as well as the forecast hours, 
display.  

 

Resource Dashboard 

We have added a new Resource Dashboard. For firms that choose to assign client work to their employees, the Resource 
Dashboard provides a view of employee forecast hours for a week as well as an alternate entry to assign client work. 
 
The Week Forecast tab on the Resource Dashboard displays a grid containing all employees with corresponding office, 
department, skill level, and employee status columns. Employee managers can filter the grid for appropriate groups of employees. 
Summaries are displayed including employee assignable hours for the week, any forecast hours entered, and the resulting 
available hours for client work.  
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The Enter Forecast Hrs tab on the Resource Dashboard displays the same forecast entry as found on the Employee Dashboard. 
This form provides a manager-driven method of assigning client work to employees. It can be used to assign all client work or it 
can be used to assign additional work when the available hours have been entered by employees and reviewed by client 
managers. If hours are entered in the Resource Dashboard, the employees will see the work assigned in the Employee 
Dashboard/My Week Forecast, with a symbol (“M”) to designate that it was assigned by a manager. 

 

Employee Week At A Glance Report 

The Employee Week At A Glance report is now available. This report helps your firm handle load balancing of client work. Use it 
weekly to analyze the employee workload and to match client work to appropriate employees who have availability. Report 
output includes employee assignable hours, forecast hours, and available hours. The report can be generated in summary or with 
the client/project/reference detail. It can be printed for multiple weeks or one week at a time.  

 

Options for Calculating Finance Charges 

Two new columns have been added to the finance charge grid for sorting and filtering. You will now find Primary Partner and Bill 
Manager as the two right-hand columns.  
In addition there are new options for printing Edit Lists. These options include: 
Group and Sort by: Clients, Primary Partner, Bill Manager 
Filter Option: Print only Selected Clients or Print All Clients in the List. 
While the Clients option continues to print in portrait, the Primary Partner and Bill Manager options print in landscape. 

 

Security Setup - Administration > Firm 

Getting Started With This Release 

New option included in this release that defaults to enabled: 
Employee Dashboard – My Week Forecast 
 
New options included in this release that default to disabled: 
Firm Dashboard – Week At A Glance 
Resource Dashboard – Week Forecast 
Resource Dashboard – Enter Forecast Hrs 
 
Firm Preferences - Administration > Firm > Firm Setup > General Information. 
New options are available for selecting the firm work week used for forecasting, including: 
Starting and ending days of the work week 
Default week selected on the calendar; current week or the next week based on your computer’s system date 

 

Dashboard User Options  
Review new Dashboard User Options, including: 
Resource Dashboard with an option for the My Week Forecast tab and the Enter Forecast Hrs tab 
My Week Forecast tab on the Employee Dashboard 
Week At A Glance tab on the Firm Dashboard 

 

Employee Week At A Glance Report 
Remind all your managers who work with employee schedules that this report is available 

 

New Finance Charge Options 
Remind all employees who manage finance charges about the new column and Edit List options 
on the new options with this release. 
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Administration 

Corrections 

Use of the keyword ‘Bill through date’ now uses the correct format when inserted into the invoice header and the header is set to 
use the long date format. 
 
Contact Management and Dashboard 
When viewing 24 months of WIP, AR or Invoice history the rounded amounts no longer include the decimal point and cents (for 
example, 325 instead of 325.00). 
 
Project Management 
Setting up a new template now pulls the name of the employee identified as the default employee for the In Charge project 
position. Additionally, copying a template to one or more clients now copies the employee chosen as the In Charge project 
position for the template. 
 
Project Tracking 
Extension form 7004 line 5a now displays the correct date for the calendar year. 

 

2012 Extension Forms Download / January 

Extension Forms are now available for Tax Year 2012. These are only needed of you print extension forms from ProSystem fx Practice 
Management.  
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Year 2012 

Release 2012.12.03 / December 

ProSystem fx Practice Management is now compatible with:  

Windows 8, Pro and Enterprise 
Windows Small Business Server 2011 
Windows Server 2012 
SQL 2012 
 

SQL 2008 R2 Express is now available with any new installation of ProSystem fx Practice Management. 

Microsoft Office 2010 OEM and Professional (64 bit) are now supported (except for Coolbar and Mail Monitor). Outlook (64 bit) will 
need to be open for Practice Management generated emails to be sent. 

Project Notes is now available in the Client Project List type report in Report Writer. 

 

Release 2012.12.02 / November 

NEW Project Based Time Entry 

Project Based Time Entry is now available as an alternate time entry method if your firm is project centric. In Project Based Time 
Entry, you enter the project before entering the service code for the transaction. You have the opportunity to set up a link 
between project types and permissible service codes, ensuring that your firm employees are entering accurate service codes 
available only for the project type. 
 
Enabling Project Based Time Entry is a 3-step process.  
First, set up the links between project types and service codes.  
Then enable security for employees who will now use Project Based Time Entry. 
Finally, decide whether your firm will require the selection of projects. A new option is available to require projects for nonbillable 
clients. 
 
To start, select Project Types from the navigation bar in Administration (or select Project Management > Create Lists > Setup 
Project Types). Select the project type for the linking and select the Link Service Codes tab. All service codes are linked by default. 
A quick way to create your link is to right-click, exclude all service codes, and then include only the service codes for this project 
type by clicking the Included check box. Quickly select to include multiple services by right-clicking a category or subcategory to 
filter down to a specific subgroup of services and then right-click again to include all. Linking service codes provides more 
accurate reporting by filtering the available service codes in Project Based Time Entry to just those defined for each project type. 
Once you have your service codes linked, enable security for employees who will use Project Based Time Entry. Select Security 
Setup from Administration > Firm. Look for Time Entry – Project Based Entry. Two options are available in this group.  
Click Yes for Time Entry – Project Based Entry to turn on Project Based Time Entry. In this entry method, the project is entered 
before the service code. The available service codes will be filtered if you have linked service codes to the project type.  
If you want to make available the option to override the linked service codes for any project, click Yes for Allow override of service 
codes. 
 
When entering time in Project Based Time Entry, you will see that the project is the second entry item after the client name. 
Enter the project before entering the service code. Once you enter the project, the linked service codes for the project type are 
available in the service code lookup. If you have security to override the filtered list, click the Trim/Untrim button [<] [>] to 
display/trim the full list in service code lookup. This may be helpful, for example, if you are working on a 1040 project and need to 
enter an expense service code (such as postage) which could be used for any project type. 
 
Note also that if employees use Timers, the Timer window will also display in Project Based Time Entry order if this alternate time 
entry method is selected for the employee. 
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Time Entry Project settings for nonbillable clients are now available in Firm Setup > Time Entry.  

If you select to require selection of a project in Time Entry on this tab, you can also now require the entry of a project for 
nonbillable clients as well. If you select both check boxes, “No Selection” is not an option for project selection in Time Entry. 

 

NEW Timesheet Column Preferences 

Preferences for Timesheet Columns are now available. All staff members now have the ability to set up their preferences for the 
columns to view in their timesheet. 
 
Select My Time Entry Column Order from the Preferences menu to customize the columns in your timesheet in Time Entry. The 
Selected Column list shows the current columns. By default, all columns display in the Selected Columns list the first time you 
open this preference. You can change the order of columns by moving them up or down in the list. Remove any unwanted 
columns from the list by highlighting them and clicking <- Remove to move them back to the Additional Columns Available list. 

 

NEW Employee Semi Monthly Timesheet Available in Time Entry 

The Employee Semi Monthly Timesheet report has been added to the Activities menu in Time Entry. It is also still available from 
the Reports module. This is helpful for firms who want employees to sign and submit a report for payroll purposes. 

 

NEW Client Notes Location in Client Dashboard 

Dashboard Notes now display on a separate tab in Client Dashboard giving you the opportunity to scan multiple notes at a 
glance. You can now add a note from the Client Notes tab in Dashboard. Marketing ticklers, follow-ups, and appointments can 
also be added by selecting the New button. You can also edit or delete any note, tickler, follow-up or appointment from this tab. 
Additionally, notes can now be printed from the Client Notes tab in a report format sorted by type, source, topic, contact, date, 
or employee. 
 
As a new tab, the security for the Client Notes tab is disabled for all users. To simply allow access to the tab for all users, select 
Default for All Employees in Security Setup (Administration > Firm > Security Setup), look for Client Notes under Client 
Dashboard and select Yes. To set the Client Notes tab as a default tab, select User Options > User Default View > Client 
Dashboard and select Client Notes. 
 
From the Client Dashboard, select the Client Notes tab. You may add, edit, or delete client notes as well as marketing ticklers, 
follow-ups, and appointments from the Dashboard. By default, the Summary check box is selected, displaying only the first 
portion of each note. To view the entire text of a single note, select the note and the content will display in full at the bottom of 
the tab. To view the complete text of all notes for the selected client, clear the Summary check box. 
 
You can also select which columns of information to view. Select My Notes Column Setup from Notes Column Preferences to 
select from Type, Source, Topic, Contact, Date, Employee, and Note. By default, all columns display in the Selected Columns list. 
You can change the order of columns by moving them up or down in the list. Remove any unwanted columns from the list by 
highlighting them and clicking <- Remove to move them back to the Additional Columns Available list. 

 

NEW Clearing Project Notes 

Clearing Project Notes when Rolling Projects into the new year is now available. This may be useful if your firm migrated data and 
uses project notes tied to a specific year (for example, for the 2011 Tax season). If your firm uses the Auto Roll feature, the option 
to clear the notes from a project can be configured for each project type within the Project Type setup (select Project Types from 
the navigation bar in Administration or select Project Management > Create Lists > Setup Project Types). A new check box, Clear 
the project note in the new year, displays on the Auto Roll Forward tab. Select this box to clear the note when the project is 
automatically rolled forward. 

 



10 
 
 

If your firm does not use the Auto Roll feature, a new check box, Clear the project note in the new year, displays on the Project 
Options tab of the Roll Multiple Projects to New Year window. Enable this check box to clear notes for the selected projects when 
rolling projects to the new year. 

 

NEW Client Billing Realization Report 

The Client Billing Realization report is now available. This report helps you determine the profitability of clients, employees, 
partners, managers, billers, offices, work codes, etc. Use it whenever you need to analyze the historical activity in your firm. The 
report generates a billing realization showing total billed hours, standard production amounts, invoiced amounts, write-
ups/write-downs, cost, profit, gross progress, and gross payments based on the selected invoice post date range. Detail options 
include category, subcategory, service code, and project. 

 

NEW Employee Time Analysis Report 

The Employee Time Analysis report prints a summary of employee current period and year-to-date posted hours and amounts. 
This report helps you monitor how effective your staff has been by analyzing how much time every employee spends on each 
client, project, and work type. Production and cost summaries can be included for additional analysis. Detail options include 
category, subcategory, service code, client engagement, and project type. 

 

NEW WIP AR Summary Report – Unposted WIP 

The WIP AR Summary now includes an additional column for Unposted WIP. 

 

NEW Updated Look 

Practice Management now has an updated look and feel for navigation bars and buttons. Navigation bars have a light blue 
background with blue text while buttons have blue borders. All navigation bars and buttons function the same as in previous 
versions of the software. 

 

Release 2012.12.01 / May 

We have devoted this release to making enhancements and corrections to the following areas of ProSystem fx Practice Management: 
After installing this release, we recommend staff security for the new Project Dashboard, the new Self Assign feature for Project 
Tracking, and the new Firm Dashboard tab for My Project Overruns be set up to take advantage of the new features in this release. 

 

ProSystem fx Practice Management Report Writer has a new look and feel. The Report Writer now opens fully maximized for ease of use 
requiring new minimum screen resolution of 1024 x 768. 

New Main Window: Upon opening, a right-hand window displays. This window contains a quick overview of available options 
when creating or editing reports. Navigate easily and quickly from the Report List to the Customize mode or to the Run mode.  
 
Select a Report Type, and the Customize mode options display. Once the report is saved, the Run mode can quickly be launched 
from within the current window. Select an existing saved report and the Run mode options display to configure the printing 
parameters and print. You can also easily return to the Customize mode. 
 
Navigation bar: Customize the Custom Report has been added to the right-click options for existing saved reports. Navigate from 
report to report and stay in the navigation bar once in Customize or Run mode. 
 
Use splitter bars to size both the navigation bar as well as the right-hand window. Report Writer now saves and loads changes to 
your custom window sizes. 
 
Grouping and Sorting: A Grouping and Sorting tab has been added to the Customize options. Set the sorts and grouping options 
during the report’s creation. These selected sorts and groups default at print time. 
Custom Names: Client management positions and milestone dates now use custom firm names for selection on reports. 



11 
 
 

New Field Display Names:  
 
Standard prefixes have been added to column fields for ease of use in selection when creating new reports or adding or removing 
fields on existing reports. The new field display names will not affect existing reports unless a field is added. 

Type of Field New Prefix 

Accounts Receivable AR 

Banked Hours Bank-Use 

Billed WIP Billed 

Client Clt 

Client Management Clt Mgmt 

Due Date Milestone 

Employee Employee 

Project Project 

Project Detail Project Detail 

Service Service 

WIP WIP 

 

New Report Fields:  
Report fields have been added to several Report Types. 

New Field Name 

Client Profile Information 

Report Type 

Project Detail List 

 

New Field Name 

Client Active Date 

Report Types 

Accounts Receivable 

Billable Work in Progress 

Billed Detail 

Employee NonBillable Detail 

Employee Timesheet Detail 

MTD/YTD Client Production 

MTD/YTD Employee Production 

MTD/YTD Client Billing 
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MTD/YTD Employee Billing 

Project Detail List 

 

New Field Names 

Project Type 

Project Description 

Project InCharge 

Project Current Due Date 

Report Types 

Billable Work in Progress 

Billed Detail 

Employee NonBillable Detail 

Employee Scheduling 

Employee Timesheet Detail 

MTD/YTD Client Production 

MTD/YTD Employee Production 

MTD/YTD Client Billing 

MTD/YTD Employee Billing 

 

 

New Field Name 

Billable/Nonbillable 

Report Types 

Employee Timesheet Detail 

MTD/YTD Client Production 

MTD/YTD Employee Production 

 

New Field Name 

Clt Engagement Num (Engagement Code) 

Report Type 
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Accounts Receivable 

Billable Work in Progress 

Billed Detail 

MTD/YTD Client Billing 

MTD/YTD Employee Billing 

Project Detail List 

 

New Field Name 

Clt Name - Sort 

Report Type 

Accounts Receivable 

Employee NonBillable Detail 

Employee Timesheet Detail 

MTD/YTD Employee Production 

MTD/YTD Employee Billing 

 

New Field Name 

Clt Name - Full 

Report Type 

Employee Scheduling 

Project Detail List 

 

NEW Custom invoicing options have been added with this release. 

Custom Invoice Headers-Footers: Custom headers and footers can be added in Invoice Format Setup (Administration > Firm). To 
set up a custom header-footer set, enter the description and specify the language (English or French). You can associate a custom 
header-footer set with an office (or group of offices) selecting the check box(es) to the left of the desired office(s). Once the 
selections have been made, click Save Settings. Options are also available to select the font and size you want to use for your 
custom headers and footers. Review the existing selection on the Office Options tab in Firm Setup to determine if the current 
selection will continue to be the best option for the firm if assigning a custom header-footer as a default for an office. 
Override Header-Footer: Select to override the default Firm or the default Office header-footer with a custom header-footer in 
Client Setup (Billing tab). By default, no value will be selected. If a custom header-footer has not been selected and a default 
exists for the Office (as determined by the Office Options tab in Firm Setup), then the Office default will be used. If a custom 
header-footer has not been selected and an Office default does not exist (as determined by the Office Options tab in Firm Setup), 
then the Firm Default will be used. The Firm Default can be selected to override the Office default. 
Client Find and Change: Client Find and Change has been enhanced to include Override Default Invoice Header-Footer. Use this 
to quickly override default header-footer settings for multiple clients one at a time or all in one batch. 
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The Budget to Actual report has been enhanced.  

This Project report now can be printed with both hours and amounts for a total of 6 columns (7 columns if actual fees are also 
included). While the default remains to include just budget hours, both fees and surcharges may be selected if the report criteria 
includes both hours and amounts. 

 

The Employee Semi Monthly Timesheet report has been added.  

This NEW employee report prints timesheet information in up to 16 columns depending on the date range selected. The default 
date span is 16 days and the To Date will default to 16 days after the Start Date entered. The report includes a column for each 
day with separate billable and nonbillable sections and total rows. Billable and/or Nonbillable detail can be summarized. Detail 
rows can be sorted by Category, Subcategory, Service Code, Client Engagement, or Project Type. The report can be filtered and 
grouped by standard employee fields including Office, Region, Department, and Skill Level. 

 

NEW Dashboard options are now available. Security for these options has also been added to Security Setup and default to No. 

To check Dashboard security, select Administration > Firm > Security Setup and search for the Firm Dashboard-Project Overruns 
and Project Dashboard security areas. In addition, there is a new security setting for employees to assign themselves to projects 
on the new Project Dashboard. You will find the Self Assign security in the Project Tracking (Dashboard) Privileges section of 
Security Setup. 

 

Project Dashboard 

A NEW Project Dashboard now displays Project Tracking views. You can also set project status from this dashboard. To access the 
Project Dashboard, set up security for employees in the Project Dashboard security area in Security Setup. By default, this option 
will be disabled for all users. Like all Dashboards, the Project Dashboard can be set as the default view upon launch of the 
Dashboard. 
 
The default Track Projects view shows project information based on the criteria selected from the navigation bar. Options include 
loading the project by Project Type, Client, Project Status, Primary Partner, Secondary Partner, Responsible Person, Manager, Bill 
Manager, Tax Reviewer, Tax Preparer, In Charge, Entity Type, Work Type, Line of Business, Assigned Position, Assigned Employee, 
Assigned Skill Level, and Assigned Team. Once the grid has been loaded, use the View Projects, Project File Locator and Set 
Project Status buttons to help track the projects. To adjust column preferences, see Project Tracking Column Preferences and 
select Project Tracking Column Setup. 
 
The NEW Track Milestones view provides a view of projects as they move through the firm, from waiting for information to the 
delivered project. Each milestone displays the most recent project milestone date that has been updated for the project. These 
dates include: Received, Prepared, Reviewed, Completed, and Delivered. Select Waiting for Information to build a list of projects 
which have yet to achieve a milestone. Once the grid has been loaded, use the View Projects, Project File Locator, and Set Project 
Status buttons to help track the projects. To adjust column preferences, see Project Tracking Column Preferences and select 
Project Tracking Column Setup. 
 
The NEW Track Detail Tasks view provides a view of the detail tasks that have been set up for a project. Load the grid with detail 
tasks by Client, Assigned Position (including All, No Selection, as well as each project position set up in Project Management), 
Assigned Employee, or Assigned Skill Level. Static columns include Sort Order Date, Client Sort Name, and Received. The default 
columns include Project Type, Project Position, Employee Last Name, Employee First Name, Client Number, Engagement 
Number, Detail Budget Hours, Budget Amount, Expense, SC Cat, SC Sub, SC Detail, Budget Item Completed, In Charge, and 
Client Name. Available columns include Project Description, Project Start and Target Date, Team, Detail Task Start and Target 
Date, Office, Skill Level, and Note. 
To change the column preferences, see Project Tracking Column Preferences and select Project Detail Tasks Column Setup. 
 
A NEW Self Assign option is available when displaying projects in Track Detail Tasks view By Assigned Position (with the 
exception of by ALL). This option enables employees to assign themselves to a chosen project task, if an employee has not been 
assigned. If another employee is already assigned, a message displays informing the employee that the change could not be 
made. This new option provides quick visibility for the firm. To enable self assign for employees, go to Security Setup and the 
Project Tracking (Dashboard) Privileges section. 
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Firm Dashboard Enhancement 

A new tab, My Project Overruns has been added to the Firm Dashboard. Select the tab to list projects along with columns for the 
associated budgeted, actual and variance hours as well as amounts. By default, the Show Overruns ONLY checkbox is enabled. 
Overruns can be displayed by Hours or Amounts. 
Security for this new tab is available in the Firm Dashboard section of Security Setup.  By default, this option will be disabled for 
all users. 
 
Project Tracking has been enhanced. Two new views (Track Milestones and Track Detail Tasks) have been added. These views have 
the same functionality as their Project Dashboard counterparts. A column preference has been added for the Track Detail Tasks 
view (My Project Detail Tasks Column Setup). The Self Assign option is also available in Track Detail Tasks on the Assigned 
Position view. 

 

2011 Extension Forms Download / January 

Extension Forms are now available for Tax Year 2011. These are only needed of you print extension forms from ProSystem fx Practice 
Management.  
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Year 2011 

Release 2011.11.03 / November 

On the Practice Management 2011.11.02 October release, the Roll Projects to New Year feature was enhanced with a new view for 
projects already rolled to the new year. However, the view of unrolled projects still showed rolled projects if the project description was 
cleared or changed during the roll. The view of unrolled projects has been corrected to no longer include projects with changed 
descriptions following a roll of one or more projects. 

 

Release 2011.11.0 / October 

NEW Dashboard Enhancements 

ProSystem fx Practice Management has a NEW Client Dashboard designed to combine client data from multiple areas into a single easy 
to use tool. Many additional enhancements have also been implemented for existing Dashboards. Standard Practice Management grid 
controls can be applied to further filter, print, or export the displayed data. 

Please review security for the entire Dashboard module after updating to 2011.11.02 to validate that each staff member has the 
appropriate access for their position within the firm. 

 

NEW Client Dashboard 

This dashboard is designed for firm management and includes four tabs: 
 
Contact Information:  

This tab consists of five panes divided into two main sections. The General Information, Notes, and Contacts panes 
display in the upper section while the Balances and Invoices panes display below. 
The General Information pane provides basic information including physical and mailing addresses, assigned staff, 
and other profile information such as fiscal year end and taxpayer ID. The client’s physical and mailing address can be 
edited from this pane. 
The Notes pane displays all notes, appointments, follow-ups or tasks associated with the selected client in grid 
format. Select an item from the grid to display the detail. To edit a note, simply double-click the desired note. 
The Contacts pane shows each of the contacts for the selected client. To edit a contact, select the contact and click 
Edit Contact. New contacts can be created as well as existing contacts deleted. Notes for contacts can also be 
viewed.  
The Balances pane allows for quick review of the client’s Billable WIP, Progress, Net WIP, AR Balance as of the 
current system date/time as well as Last Invoice Date. 
The Invoices pane lists each of the client’s current outstanding invoices including the original amount and any 
outstanding amount per engagement. To view an invoice, simply double-click anywhere on the row for the desired 
invoice. 

 
PTD/YTD Activity: This tab consists of two panes.  
 

The PTD/YTD Activity pane reconciles the WIP and AR activity for the selected client based on the chosen date 
range. 
The Activity Detail pane is further divided into PTD and YTD tabs listing the posted WIP and AR detail for the chosen 
date range. Each column is totaled at the bottom of the grid. 

 
Current / Prior Year: This tab consists of two panes. 

The Monthly Comparison pane shows current and prior period Production, Billed Hours, Billed Amount, Billed 
Adjustments and Payments broken down by month for up to 12 months for the selected client based on the chosen 
date range.  
Optionally you can choose to view the data in the Monthly Comparison pane for only billable WIP.  
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The Production pane is further divided into two tabs: Employee and Service Code. The Employee tab shows the 
difference between production and billing totals for the selected client within the chosen current and prior periods 
by employee. The Service Code tab shows the difference between production and billing totals for the selected client 
within the chosen current and prior periods by service.  

 

All Engagements:  

This tab shows engagement specific information such as the engagement’s description, fee and date of the last 
invoice. In addition, current and prior Production, Billing, and AR display for comparison broken down by months 
within the firm’s fiscal year. You can choose to see just one type of information, for example Billing, or select Show 
All 3 to see all three types of information. Information can be summarized for multi-engagement clients. 

 

Dashboard Security 

Dashboard security has been enhanced to provide more security flexibility and control access to each dashboard as 
well as to individual tabs. The Firm and Client Dashboards default to disabled for all users. Previously, security for the 
Firm Summary tab of the Firm Dashboard was linked to rights to the Firm Management Key Indicator report under 
Time Entry. The Employee Dashboard defaults to enabled for all users.  

 

Please review Dashboard security to verify that access is appropriate for each of your firm’s staff members, based on 
their firm position.  
 
To check Dashboard security, select Administration > File > Security Setup and search for the Firm Dashboard, 
Employee Dashboard, and Client Dashboard security areas. 

 

Dashboard Accessibility 

Access Dashboard like any Practice Management module using the Features menu or Tray. To open Dashboard from 
another module, select the Features menu and choose Dashboard. From the Tray, right-click the Tray icon, navigate 
to Practice Features Launcher, and choose Dashboard.  
 
Dashboard can also be set as the default module by double-clicking the Tray icon. To set Dashboard as the default 
module, right-click the Tray icon and select Preferences. On the General tab, verify Practice Features Launcher is 
selected. Select Practice Features Launcher from the navigation bar. Click the drop-down for Default Feature, choose 
Dashboard, and click Save. Double-click the Tray icon and the Dashboard module launches. 

 

Firm Dashboard Enhancements 

Firm Dashboard by Client Mgmt Position: Separate firm level dashboards for each client management position are replacing the 
single firm level dashboard. Each client management firm level dashboard has the same tabs: Firm Summary, My Summary, My 
Projects, and My Clients. The data loads differently for the Firm Summary tab than for the other tabs. For example, selecting Firm 
Dashboard by Bill Manager loads and presents data for the Firm Summary tab by Bill Manager for all clients regardless of staff 
assigned as Bill Manager. The data for the My Summary, My Projects, and My Clients tabs loads based on client staff assignment 
loading only those clients to whom the logged on employee is assigned as Bill Manager. To set a particular client management 
node of the Firm Dashboard as a default, select User Options > User Default view. 
Firm Dashboard – My Projects (Notes): A Note pane has been added at the bottom of the grid on the My Projects tab to broaden 
the accessibility of this feature. The Note pane at the bottom of the grid is the same as the Note pane within a project’s folder 
and functions in a similar manner.  
To view a project’s notes without opening the project, simply select the project and the associated note displays in the Note pane 
at the bottom of the grid. To add or edit a note, select the project and click into the Note pane.  
Firm Dashboard – My Clients: A new tab, My Clients, has been added to the Firm Dashboard. Select the tab to load a list of clients 
based on the selected client management position. Client order defaults to client code displaying totals for Un-posted WIP, 
Billable WIP, Progress, Net WIP, and AR Balance. Un-posted time is NEW. All displayed totals are current as of the system 
date/time.  
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Employee Dashboard Enhancements 

Employee Dashboard – My Time: Banked and Used hours have been added as distinct views to Timesheet Lookup pane of the My 
Time tab of the Employee Dashboard.  
The Banked view displays transactions where time was banked for future use as well as the timekeeper’s Yearly Allowance, Hours 
for Date Range, and Remaining Hours. 
The Used view displays transactions where time was banked for future use as well as transactions where banked time was used. In 
addition to the detail, the Used view shows Total Banked, Total Used, and Net Hours. 
To select either the Banked or Used views, select My Time within the Employee Dashboard. Select either the Banked or the Used 
view from the View drop-down for the Time Entry Lookup pane. 

 

Additional Practice Management Enhancements 

Firm 

Preventing entry of non-billable time to billable clients is a new Firm level option. When enabled, this new option prevents 
timekeepers from charging a non-billable service to a billable client. Firm Administrators can still use Correct WIP to correct a 
billable service to a non-billable service if desired. 
To enable the option, open Firm Setup selecting the General Information tab and deselect the check box for Allow Non-billable 
Time to Billable Clients in Time Entry. This option applies to all timekeepers. 

 

Contact Management 

Invoiced WIP can now be viewed along with unbilled WIP on the WIP tab within the Individual Clients lookup in Contact 
Management. 
To view the historical WIP, select the WIP tab within the Individual Clients lookup and check the box for Include History. Once 
selected the option remains enabled. 
An additional column for Invoice No is now available for selection to help distinguish billed WIP from Unbilled WIP. If a value in 
this column is zero, it represents unbilled WIP. This additional column can be added and positioned from the Preferences menu 
option My Contact Management Info/WIP. Once added, the Invoice No column may be used to sort and filter WIP details. 

 

Project Management and Project Tracking 

A Project Note pane has been added at the bottom of the grids in Project Management and Project Tracking to broaden the 
accessibility of this feature. The Note pane at the bottom of a grid is the same as the Note pane within a project’s folder and 
functions the same.  
To view a project’s notes without opening the project, simply select the project and the associated note displays in the Note pane 
at the bottom of the grid.  
To add or edit a note, select the project and click into the Note pane. 
 
When rolling projects options for building the list of clients to determine whose projects should be rolled have been enhanced. 
The list can now be built to show only projects not already rolled, only projects that have been rolled, or all projects. 

 

Time Entry 

Banked and Used hours have been added as distinct views to Timesheet Lookup for online timekeepers.  
The Banked view displays transactions where time was banked for future use as well as the timekeeper’s Yearly Allowance, Hours 
for Date Range, and Remaining Hours. 
The Used view displays transactions where time was banked for future use as well as transactions where banked time was used. In 
addition to the detail, the Used view shows Total Banked, Total Used, and Net Hours.  
To select either the Banked or Used views, select the Timesheet Lookup tab in Time Entry. Select either the Banked or the Used 
view from the View drop-down. 
Note that this feature is designed for online timekeepers. 
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Release 2011.11.01 / May 

NEW Dashboard 

ProSystem fx Practice Management has new dashboards designed for firm partners as well as firm employees.  These dashboards can be 
set up to display first when logging into the Practice Management application.  You can specify which tab of the dashboard to display 
on entry.  If you have shortcuts to Practice Management modules on your desktop, you should consider adding a shortcut to the new 
Dashboard option so you can quickly access your personal data snapshot before entering further into the application.  

 

Firm Dashboard 

This dashboard is designed for firm management and includes 3 tabs: 
Firm Summary: This tab includes all of the firm partners and displays the Work In Process, Billing, and Accounts Receivable panes 
for Period-To-Date as well as Year-To-Date totals.  Click on any partner on the Firm Summary panel to reflect information for 
only that partner. A variety of graphs is also available on these tabs to assist with interpreting firm information. From the graphs 
you can print, save as an image, or export to Excel. 
My Partner Summary: This tab is designed to reflect your partner statistics only without the entire partner list. 
My Partner Projects:  This is a list of projects for clients where you are the partner and the projects have not been delivered. 

 

Employee Dashboard 

This dashboard is designed for firm employees and includes 3 tabs: 
My Calendar View: This is a month view of your time, budgets and availability. 
My Time:  This is a two-week glance at your time. 
My Assignments:  This is a list of projects where you have been assigned to a task. 

 

Default View 

You may choose the tab on the Dashboard that will be your default view as you enter Practice Management.  To do so, select 
User Options > User Default View. 

 

Requirements 

1024 x 768 or higher resolution is required for Dashboard. 

 

Security 

Dashboards and the features on the Dashboards are controlled by your existing security setup. The Firm Summary tab of Firm 
Dashboard is available to those with security for Firm Management Key Indicators - Firm Management Report in Security Setup. 
The My Partner Summary and My Partner Projects tabs are available to employees assigned to one or more clients as a partner. 

 

Administration 

Billing has been added as a new note type in Client/Prospect Note Setup. When printing Billing Worksheets, a new option to 
include Billing Notes enables you to print them on the worksheets. 
Credit Card now defaults as an entry in the Bank Account list for new installations/databases of Practice Management. 
 

Accounts Receivable 

The option to summarize finance charges has been added to the new Format tab in Print Accounts Receivable Statements. This 
new tab also includes Format Type (Balance Forward or Open Item), formerly on the Page Setup tab, as well as the option to 
suppress printing of voided entries formerly on the Print Criteria tab. If you select to summarize finance charges, the description 
of Finance Charge prints as the last row in the current activity section of the statement without a date. The amount is the sum of 
outstanding finance charges and any applied debits and credits through the user-defined cutoff date.  
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Billing 

Change Bill Thru Date button has been added to the main billing form. This functionality has also been retained as a button 
within the Client Detail Billing. When the Bill Thru Date is changed, a new column displays on the main billing window to assist 
with your billing decisions. This column contains all posted billable WIP entered on or before this date, netted with any unapplied 
progress, for each client in the list. 
 

Project Management  

Automatic Roll Forward can now be set up for any project type. A new Auto Roll Forward tab in Project Type allows you to set 
this option. Three options are available to keep the existing description, clear existing description, or use a new description. This 
automated roll forward will function only for projects without budget detail. 
To initiate the roll forward for a project with an auto roll enabled project type, enter the Delivered Date for the project by 
updating Tracking Status from any online module in ProSystem fx Practice Management. When you click OK, the project will roll 
forward to the new year. 
Note that for existing projects, enabling of auto roll for a project type may affect existing delivered projects that have not yet 
been rolled to the new year if these projects’ tracking dates are reviewed. 

Reports 

New Secondary Sorts are now available on the following reports: AR Cash Receipts, AR Balance Listing, AR Collections, and Billing 
Report. Each primary staff position sort (for example, Primary Partner) can be further sorted by either a secondary staff position 
sort (for example, Primary Partner by Bill Manager) or a secondary staff position sort and a sort by group (for example, Primary 
Partner by Bill Manager by Group). Each secondary sort method continues to allow the ordering of the report output by Client 
Code, Client Sort Name, Client Master – Code, or Client Master – Sort Name. 
 
The Billing Worksheet now includes the option to include new Billing Notes. It also prints WIP Thru MM/DD/YYYY based on the 
detail criteria date to assist when identifying the make-up of WIP on the worksheet during the billing process. 

 

2010 Extension Forms Download / January 

Extension Forms are now available for Tax Year 2010.  
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Year 2010 

Release 2010.10.03 / October 

Reports 

WIP/AR Reconciliation now accurately reports WIP Prior and Current balances when using date range criteria equal to either 
Current Year or Prior Year in conjunction with a start date not equal to the first day of the firm’s fiscal year. 
 
Client Ledger now accurately reports WIP Prior and Current balances when using date range criteria equal to either Current Year 
or Prior Year in conjunction with a start date not equal to the first day of the firm’s fiscal year. 

 

Release 2010.10.02 / September 

GL Interface 

General Ledger Interface is now available for Client Accounting Suite. To set up the interface, select General Ledger Interface 
from the File menu in Administration. Use this interface to create journal entries from ProSystem fx Practice Management. 
Transactions will be written to a table which can be imported into Client Accounting Suite for General Ledger reporting. 

Payroll Interface 

Payroll Interface is now available for Client Accounting Suite Payroll. To set up the interface, select Payroll Interface from the File 
menu in Administration. Use this interface to transfer payroll timesheet information from ProSystem fx Practice Management to 
Client Accounting Suite Payroll. Paychecks can then be printed in Client Accounting Suite Payroll. 

 

Release 2010.10.01 / September 

Firm 

Three new default invoice formats are now available: Project WIP Detail – By Category, Project WIP Detail – By SubCategory, and 
Project WIP Detail – By Service Code. 
 
These invoice formats group WIP transactions by category, subcategory, or service code ordered by date and subtotaled by 
project. 

 

Contact Management 

Open AR Balance Only is a new checkbox on the AR tab of Contact Management. Selecting this new checkbox removes items 
paid in full, showing only those items on which an outstanding balance is owed. This checkbox is a per user option and remains 
selected regardless of client until it is deselected. 
AR Net is a new column you can add to the AR tab of Contact Management to show the net amount remaining for those items 
with an outstanding balance. To add this column, go to Preferences/My Contact Management Info/AR. 

 

Reports 

New Secondary Sorts are available on the following reports: AR Aging, AR Reconciliation, Billing Worksheet, WIP/AR Aging, 
WIP/AR Reconciliation, and WIP/AR Summary. 
 
Each primary staff position sort (for example, Primary Partner) can now be further sorted by either a secondary staff position sort 
(for example, Primary Partner by Bill Manager) or a secondary staff position sort and a sort by group (for example, Primary 
Partner by Bill Manager by Group). 
 
Each secondary sort method continues to allow the ordering of the report output by Client Code, Client Sort Name, Client Master 
- Code, or Client Master - Sort Name. 
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Features Menu 

CPE Assistant is a new link on the Features menu to the website http://cpeassistant.com. This tracker helps CPAs monitor and 
maintain their CPE certification. 

 

Help Menu 

Technical Support selection on the Help menu is now called “ProSystem fx Practice Management support on the web.” Six 
additional selections have been added under the updated Help menu option: 
   Product Home Page 
   Product Updates 
   Efx News 
   Browse our Knowledge Base 
   Contact Support 
   My Account 

 

2009 Extension Form Download / January 

Extension Forms are now available for Tax Year 2009.  

 

  

http://cpeassistant.com/�
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Year 2009 

Release 2009.90.02 / October 

ProSystem fx Practice Management is now compatible with Windows 7 Enterprise, Windows 7 Ultimate, and Windows 7 Professional.  

Accounts Receivable 

Payments in Balance Forward detail are labeled correctly on the statement when applied to an invoice reported in the statement 
current activity. 

Project Management 

Inactive clients no longer display in Project Management lookup. 

Time Entry 

Employee Management Report headings now display as PTD and RTD. 

Reports 

The Employee Posted Summary now saves report criteria when you click OK. 

Report Writer 

Report Writer now processes production reports that have user-defined applied filters with improved memory allocation. 
MTD/YTD Client Employee Billing Reports now have enhanced flexibility in whether you include or exclude expenses in the 
realization percent. The existing PTD and YTD Realization % fields will always include expenses for detail and total rows. New 
fields have been added to never include expenses for detail and total rows (PTD Realization w/o Expenses and YTD Realization % 
w/o Expenses). Select the appropriate field for the report calculation required by your firm. 

 

2008 Extension Form Release / January 

Extension Forms are now available for Tax Year 2008. This download is supported for version 2007.70.01 or higher. 
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Year 2008 

Release 2008.80.02 / August  

Enhancements in this release are centered on CCH Coolbar features. 

Users who release their time to the firm administrator may now release their time in Outlook. There is a new Time menu in the 
Task pane in the DataCenter. This menu includes Create Time and Release Time. Users who use the Real Time release to WIP will 
still need to release their time from Practice Management. 
Users will be able to update the project status when entering time. In addition, one or multiple employees may be marked 
complete. 
Clients may now be sorted by the client sort name. Lookup is also available by client sort name. 
There is additional security for AR lists in the DataCenter including outstanding balances and invoices. This security is based on 
report security in Practice Management. 
You may open Coolbar Options from a selection on the DataCenter menu in Outlook (in addition to Shift Clicking the Log 
button). 
Review Time Entries, WIP, Invoices, and A/R Activity are now available on new tabs in the Client Detail Views. In addition to these 
enhancements: 
The label of the Cash Receipts tab in DataCenter/Finance has been changed to A/R Activity. This tab displays one year of activity 
by default. You can remove the advanced filter to display all three years available. 
ProSystem fx Practice Management now includes the ability to enable/disable CCH Coolbar email storage as a decision for the 
firm. If you are updating from a previous version of CCH Coolbar, email storage will be enabled. To disable email storage, open 
Employee Coolbar Setup from Lists/Employees and de-select the Enable Email Storage check box. 

 

In addition to CCH Coolbar enhancements, the following CCH Coolbar correction has been made: 
AR balances displaying in CCH Coolbar are now in sync with ProSystem fx Practice Management reporting. 

 

The following ProSystem fx Practice Management correction has been made: 

AR Aging on Invoices now includes prior period invoice amounts in the aging buckets in addition to the current invoice amount.  

 

Release 2008.80.01 / May  

Remote Administration is now available in Basic Edition. 

 

Export to Excel is available from the right-click menu on any list or grid. If you select this right-click option, the list is moved directly 
into Excel, instead of filtering it through a report format first. The number of columns in the generated Excel spreadsheet is not limited 
by the number of columns on a list and includes all available columns (up to 99) without wrapping text within a column. 

 

The new Excel .xlsx format is now available from Print to Excel if Office 2007 is installed. The new .xlsx format overcomes Excel version 
2003 and prior limitations with large spreadsheets, allowing over 65,536 rows in a spreadsheet. If you have Office 2007 installed and 
you anticipate having a large spreadsheet (over 65,536 rows) you must save to the .xlsx format. If you do not have Office 2007 installed 
and you anticipate having a large spreadsheet, an .xml file will be created. This .xml file can then be opened in Office 2007. Regardless 
of the version of Office installed, the Row Start and Column Start options are no longer available and text that exceeds the column 
width will be wrapped when choosing Print to Excel. 

  



25 
 
 

Year 2007 

Release 2007.70.03 / January  

Extension Forms have been updated for Tax Year 2007.  

 

Release 2007.70.01 / August  

Microsoft® Vista compatible items include.  

Calendars (used in the drop-down for date fields) have been enhanced. 

ProSystem fx Practice Management is compatible with Office 2007 (Word and Excel). New .docx files (available with Word 2007) can 
be used in mailers and letters in the Marketing and Contact Management modules. 

Updatedb.exe is now Versiondb.exe. 

Workstation Setup now installs Microsoft® SQL Express instead of MSDE when installing Remote components. MSDE is still supported 
for server installations and for all Remote workstations. Microsoft SQL Express will also be used for all NEW server installations (instead 
of MSDE) if SQL is not detected on the server. 

 

ProSystem fx Permission Key for software licensing is included with this release.  

This change (also used for support, distribution, and billing) replaces your current client number with a new ProSystem fx Practice 
Management account number. 
Permission Key Options are now part of the ProSystem fx Practice Management installation. You will need your ProSystem fx 
Account Number (the Business ID number on your distribution kit packing slip) and password (obtained by calling Customer 
Support at 1-800-PFX-9998). Use the ProSystem fx Account Number as your User ID when downloading the permission key from 
the Internet. Check the Installation Guide for complete instructions on the Permission Key. 
The Support Website is transitioning from our present Support site to CCHGroup.com. Support options at CCHGroup.com are 
available to all staff members. The User ID and Password are not required to log onto this site. Any software downloads from the 
Support Website cannot be licensed without obtaining a Permission Key (which does require the User ID and Password for 
security). 
Use your ProSystem fx Account Number when logging Support calls. 

 

Report Writer has transitioned from Crystal Reports (for report generation), making this feature Vista compatible.  

All existing reports written in all 2006 versions of Report Writer can still be generated with this new version. 
When running Workstation Setup, the Crystal Reports option is no longer needed.  
Most Report Writer options are the same as those in versions prior to this release.  
“Group by” functionality on the Report Format tab has been expanded for totaling on all sorts (previously limited to sorts 1-3). If 
you select to group by a sort, you can also subtotal and page break on that sort criteria. Grouping and subtotals must still be 
selected for each sort. Report processing time is related to the number of groups selected for the report.  
In View Layout, the first 20 lines from the final report display as a preview in the layout function, instead of the generic words and 
numbers previously generated by Crystal Reports. 
When printing reports, report subtotals line up vertically with the report headers and report detail. 
Export options from the Report Viewer include these document types: PDF, HTML, Text, CSV (comma separated values), MHT 
(multi-purpose Internet mail extension html), Excel, Rich Text, and Graphic. 

 

AR Statements show all finance charges summarized by invoice number to display one line item per invoice no matter how many 
engagements make up the invoice. 

 

General Ledger Interface includes an export to ProSystem fx Write-Up version 3.5 or higher. Identify the department type representing 
offices in the Write-Up Chart of Accounts. Then link specific items/types from the Chart to specific ProSystem fx Practice Management 
offices. The journal entries are exported directly to the Write-Up database. 
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SQL Utilities now requires Administration rights for security with Vista.  Other changes to SQL Utilities include: 

SQLbackuprestore.exe, SQLattachdb.exe, and SQLdetachdb.exe are not compatible with Microsoft SQL 2005 and are no longer 
active.  
SQL Utilities options which are no longer active include the right-click Maintenance option from the Database menu and 
SQL/Configuration Version from the Help menu. If you are running SQL 2005 or SQL 2005 Express, use the Microsoft SQL 
manager (a free tool that can be downloaded from the Microsoft website) for backups and for SQL database manipulation.  

 

Screen Positioning is now available on dual monitors if you are running Citrix or Terminal Services. Open the Help menu and select 
Screen Positioning. Follow the instructions to identify the default monitor and positioning of all windows. 

 

The CPAS Viewer File (CPASNViewer) is no longer active with this release. ProSystem fx Practice Management now exports directly to 
PDF format and this feature is no longer needed. 

 

Log a Call Through the Internet and Download License File via the Internet are no longer active with this release due to the transition to 
the ProSystem fx Account Number (Permission Key) and Vista requirements. 

 

The location of the cpas.ini and pmnet.ini files has changed with this release.  The cpas.ini and pmnet.ini files are no longer stored in the 
Windows folder of the local workstation. Instead they will be placed in a proprietary directory folder based on your operating system. 

 

CCH Coolbar, a NEW workstation add-on for ProSystem fx Practice Management, is available with this release.   

Contact your sales representative for more information. Licensing CCH Coolbar disables Appointments in ProSystem fx Practice 
Management for the firm as Outlook replaces this feature. Setup options for CCH Coolbar appear on the new File menu in 
versiondb.exe. Use CCH Coolbar to: 
 
Extend Outlook as an enterprise tool by linking Outlook emails, appointments, and tasks to clients, business affiliates, leads, and 
referrals in the ProSystem fx Practice Management database. 
 
Enter Time in Outlook from the tasks and appointments that are often the basis of billable time. 
 
Gain quick access to the wealth of client, business affiliate, lead, and referral information stored in the ProSystem fx Practice 
Management database, within the framework of Outlook. 
 
Review live firm information (such as AR, WIP, cash receipts) from ProSystem fx Practice Management in Outlook. 
 
CCH Coolbar honors the ProSystem fx Practice Management security established for the firm employees in Security Setup. It 
does not honor client trims. If your firm uses client trims in ProSystem fx Practice Management, they will not be available in CCH 
Coolbar. 
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Year 2006 

Release 2006.60.03 / January  

Extension Forms have been updated and modified for Tax Year 2006. Two extension forms are now available: Form 4868 and Form 
7004. Use Form 4868, Application for Automatic Extension of Time To File U.S. Individual Income Tax Return to extend 1040 projects. 
Use Form 7004, Application for Automatic 6-Month Extension of Time to File Certain Business Income Tax, Information, and Other 
Returns for business tax (1120, 1120S, 1065, etc.) and other tax projects. 

Allow Rate and Amount Corrections Before Lock Reconciliation has been added as a Security option in Administration and is set to Yes 
by default. If you change this option to No, the rates and amounts in Correct WIP-Unbilled for WIP transactions dated prior to (or the 
same as) the lock reconciliation date cannot be modified by the employee. 

 

Release 2006.60.01 / June  

The ProSystem fx Tax Link is now included as part of the ProSystem fx Practice Management software and is no longer an add-on that 
must be purchased separately. If your firm uses ProSystem fx Tax, see the online Help system in ProSystem fx Practice Management for 
more information on setting up the Link. 

 

Certain add-on products and features previously available in CPAPractice Manager were not initially available in ProSystem fx Practice 
Management.  The following add-ons are now available: 
   General Ledger and Payroll Interface 
   Professional Services Custom Report Library 
The following features are now available: 
   Canadian Custom Options and Date Settings 
   Loadtime Utility 

 

Employee Internet Time Entry Setup (available from Administration/Employees) is only active if your firm has purchased the NEW 
optional Internet Time Entry ADD-ON. Use this option to identify the employees who will have access to Internet Time Entry.  The 
window displays the employee name, employee code, status, and office, and can be sorted by any column.  Select the check box to 
activate Internet Time Entry for an employee. Only those employees who are selected will be able to access Internet Time Entry. The 
number of available licenses displays for reference, as well as the number of employees selected for Internet Time Entry. If you purchase 
Internet Time Entry, note that Internet Time Entry and ProSystem fx Practice Management must stay in sync on the same version. If 
your firm installs a new version of ProSystem fx Practice Management, you must also install the same version of Internet Time Entry. 

 

Expenses Always 100% (available from Administration/Firm/Firm Setup) allows you to set a firm preference that will exclude expenses 
from Billing write-up/down calculations when calculating using Employee Bill Amounts.  The option to allocate write up/down amounts 
by hours excludes expenses automatically.  Firms will continue to have a choice of which allocation method to use but now have more 
flexibility with this option. Use this option if your firm calculates write-up/down amounts using Employee Bill Amounts and wants to 
exclude expenses. There will be a secured option to override this decision in Quick Bill, Adjust Selected WIP, and Partial Bill for on-the-
fly biller decision making. 

 

Security for Onscreen Status Billing is available with five invoice review statuses for use by your firm in onscreen billing.  In some firms 
decisions about the final or approved status of a bill is only made by selected individuals.  Security options have been added for the five 
onscreen invoice review statuses (labeled on the Status Description tab of Firm Invoice Format Setup).  The security for each is a 
hierarchical setting that gives each staff member rights to the review status they have security for as well as each level prior to that 
status in the billing cycle. For example, if a staff member has security clearance for Reviewed Status 3, they also have security for 
Reviewed Status 1 and 2, but they do not have security for Reviewed Status 4 and 5. Use Security Setup (Administration/Firm) to set 
the new security options. 

 

Force Project Selection in Time Entry (available from Administration/Firm/Firm Setup/Time Entry tab) gives firms the ability to set a 
firm preference requiring employees to select an actual project for each Time Entry transaction entered.  If your firm has increased the 
use of project and budget to actual reporting it may become increasingly important for employee data entry to be accurate. Use this 
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option if your firm is concerned about employees consistently selecting the projects with which their time is associated in order to 
achieve more accurate project statistics and budget to actual reporting. Project selection in the Timer will also be required if you select 
this optional feature. In addition, if you use the Internet Time Entry ADD-ON, projects will also be required for Internet Time Entry 
transactions. 

 

Allow Staff Assignments and Project Status Dates to be Customized gives your firm the ability to customize the staff position labels of 
employees associated with clients as well as the project tracking date labels.  You now have options (in Administration/Firm/Firm 
Setup) to customize the staff assignment and project tracking status labels to better describe your firm’s staff descriptions and project 
flow.  These customized label settings will flow through ProSystem fx Practice Management not only in list building and user 
preferences for list viewing but also for reporting. Use the Client Staff tab of Firm Setup to customize the staff assignment labels and 
the Project Status Date tab of Firm Setup to customize the project tracking status labels. 

 

Suppress CPE and Marketing Prompts in Time Entry are NEW preference items in Firm Setup to allow you to disable the Time Entry 
prompts for additional information when using CPE or Marketing service codes. These prompts are turned on by default, but if you want 
to disable them you can go to Administration/Firm/Firm Setup/Time Entry.  If these prompts are disabled, you do not have the option 
to enter additional Marketing and CPE information when entering Time. 

 

Billing by % Option gives your firm the option to enter a % of selected WIP to bill versus entering the amount of WIP to bill.  If you use 
this option the write up/down is calculated based on the difference between the total amount of WIP selected and the calculated 
amount of selected WIP using the percent to bill that you enter. Billing by percent is available in Quick Bill, Adjust Selected WIP, and 
Partial Bill. An example of one situation when this option would be beneficial is if you know that a client should get a 10% discount you 
can select to bill by percent and bill the client at 90% of the selected WIP.  The write down will be equal to the 10% discount, 
eliminating the need to calculate the actual amount. 

 

AR Aging by Master Client has been added to the AR Aging Report when printing by Master Client to summarize by invoice for multi 
engagement billing.  When this option is selected, you will only see one line per invoice when there are multiple engagements included 
in the invoice instead of a separate line for each engagement. 

 

Print Reports for Any Date Range and Save Report Selections allows you to print the majority of reports for any date range.  For many 
reports this includes the ability to print for date ranges that cross fiscal years. Because you can now print a report for any date range, 
several YTD reports were changed to accommodate this new “range-to-date” or RTD. They include: 
    

   Employee Productivity 
   PTD RTD Employee Bill NonBill 
   PTD RTD Employee Billing 
   PTD RTD Production 
   Firm Management Report (Time Entry) 
   Emp Management Report (Time Entry)  
 

A new preference has been added to reports to allow you to save your report selection criteria.   This is a per user preference.  If there 
are certain reports that you regularly print using specific selection criteria, you now only have to set that criteria one time and then save 
your report criteria. Once report criteria has been saved for a report it will automatically be set the next time you select the report. To 
select the preference to be prompted each time you print a report with different criteria than your default selections go to 
Reports/Preferences.  If you do not wish to turn on this prompt, you still have the option within each report to select Save Current 
Report Criteria from the Preferences menu.  You also have the option within the individual report preferences to Reset to Default 
Criteria. 
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Installing ProSystem fx Practice Management from a Download 

If you have purchased the Internet Time Entry add-on, remember that ProSystem fx Practice Management and Internet Time Entry 
must be in sync. If you install the latest version of ProSystem fx Pracitce Management, you must also install the same version of 
Internet Time Entry. 

Verify that you have a current backup before installing. 

ALL modules of Practice Management should be shut down, including the Tray (PMTray.exe), prior to the installation of any 
update whether or not workstation setup is required to ensure proper patching of the workstation. 

Installing ProSystem fx Practice Management is a six-step process that should be performed in the following order: 

1. Verify your ProSystem fx Account Number and Password. 
2. Release ALL time from Remote workstations (connected or not connected to the network) before the firm’s server is 

updated with this new version. 
3. Install ProSystem fx Practice Management on the server.  
4. You must run workstation setup on ALL workstations for this release to update required tools. 
5. Update your database to the current version by running Versiondb.exe. If your firm is licensed for CCH Coolbar, in 

addition to updating the database, select the File menu from Versiondb.exe and run the CCH Coolbar Data Creator to 
update the add-on. Note that CCH Coolbar is not available if you are running Windows 8. 

6. Verify your SQL backup procedures. 

 

Step 1: Verify your ProSystem fx Account Number and Password 

Your ProSystem fx Account Number is the Business ID number on your packing slip (included with this distribution kit). Your Password 
can be obtained by calling Customer Support at 1-800-PFX-9998. Make sure you have your account number and password 
BEFORE starting the installation. You will need this information to activate the permission key for software licensing. 

 

Step 2: Release All Remote Time 

If your firm has Remote workstations (connected or not connected to the network), all Remote workstations must release all time 
before the server is updated with this new version. 

 

Step 3: Install ProSystem fx Practice Management on the server 

1. Shut down everything that is running on the workstation, including the Tray and/or Practice Task Timers. 
 

2. Go to support.cch.com. 
• Type Practice in Find a Product and then select ProSystem fx Practice Management. 
• Select Updates.  
• Select to Download the self-extracting file. Enter your firm’s ID and Password.  
• You will be asked to either RUN or SAVE the update. We recommend saving the file to a temporary 

location rather than running it from the website. The temporary location must reside on a 
workstation that has Practice Management installed. You do not need to run this update from the 
server. 

• Once saved, double-click the .exe file to initiate the update choosing the extraction location for the 
temporary setup files. 
 

You must run workstation setup on ALL workstations for this release to update required tools. 
 
3. The main installation window displays. 
 
4. Select Install ProSystem fx Practice Management. 
 
5. The Setup begins loading. 
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6. A Setup Wizard window displays.   Click Next. 
 

7. The License Agreement displays. Select “I accept” and click Next. 
 

8. The Choose Components window displays. Use this window to select the components to install. The check 
box for Application Components (to install ProSystem fx Practice Management) is selected by default. 
Because you have already installed SQL Server, MSDE, or Microsoft® SQL Express, the Microsoft® SQL 
Express option will be disabled. Click Next. 
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9. Select the folder where Setup will install ProSystem fx Practice Management. Click Next to install to the 
default directory of \cpas. 

 
 
10. A  permission key is required for licensing. The same permission key can be used for all CCH Tax and 

Accounting products. Select one of the permission key options for this installation.  
 

 
 
If a CCH permission key is detected on the server, Use existing permission key will be selected by default. If 
a permission key is not detected, this option will be disabled. 
 
Select Evaluation version only as a temporary option if you do not know your ProSystem fx Account 
Number and have not obtained a password. The installation continues after selecting the evaluation version 
but you will be limited to 2 employees. Once you finish the evaluation, identify your Account Number 
(which is the Business ID on your packing slip sent with the software), and call Customer Support at 1-800-
PFX-9998 to obtain the password. Then run the installation again to become fully licensed by selecting a 
different permission key option. 
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Select Download permission key from the Internet if you want to download the permission key from the 
Internet. After clicking Next you will be asked to log in to the Single Sign-On (SSO) web page with your User 
ID (ProSystem fx Account Number) and password. 
 
Select Use permission key from drive path if you want to browse to a permission key file that is stored in a 
folder on the network or on a disk drive. Enter the location of the permission key file (or click Browse to 
locate the file). 
 
Click Next. 
 

11. Now enter information about your server and database. The server and database names default from your 
previous installation. Double-check that the defaults are correct on this window. 

 

 
 
12. You are now ready to begin installation. Click Install to begin the installation of ProSystem fx Practice 

Management. A progress bar shows that ProSystem fx Practice Management is being configured.  
 

13. A message tells you that the Installation is complete.  Click Close. 

 

Step 4: Run workstation setup 

Follow these instructions for each workstation on which you will run ProSystem fx Practice Management. You must 
run workstation setup on ALL workstations for this release to update required tools. 
 
ALL modules of Practice Management should be shut down, including the Tray (PMTray.exe), prior to the 
installation of any update whether or not workstation setup is required to ensure proper patching of the workstation. 
 
If you have not run Workstation Setup you will be prompted to do so when you open ProSystem fx Practice 
Management on that workstation. Microsoft .NET Framework 3.5/4.0 must also be installed on each workstation 
running ProSystem fx Practice Management. If you have not already installed .NET Framework 3.5/4.0, it will be 
installed as part of the Workstation Setup. Depending on the workstation’s operating system, you may be prompted 
to confirm and initiate the download and install of the necessary files. 
 
1. Shut down everything that is running on the workstation, including the Tray and/or Practice Task Timers. If 

you are updating CCH Coolbar, and if Outlook is running on the workstation, close Outlook on the 
workstation before running Workstation Setup. 
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 Select Windows key + R. Click Browse and select the drive where the application was installed (for 
example, f:\cpas\setup\vpm). 

 Select setup.exe and click Open. Then click OK on the Run window. 
 
2. The Install ProSystem fx Practice Management Workstation window appears.  Select Install ProSystem fx 

Practice Management Workstation. 
 

 
 
3. The ProSystem fx Practice Management Setup Wizard window appears.  Click Next. 
 
4. The License Agreement displays. Select “I accept” and click Next. 
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5. The Choose Components window displays.  
 

 
 
 Required components always install. This feature requires 74 MB on the workstation’s hard drive. 
 

The components selected for this workstation default. 
 
If your firm is licensed for CCH Coolbar, the CCH Coolbar check box will be enabled. Select to install the 
CCH Coolbar component and update the add-on for this workstation.  See the CCH Coolbar Installation 
Guide (…\cpas\vpm\doc\install_coolbar.pdf) for complete instructions if you are installing CCH Coolbar 
for the first time.. 
Note that CCH Coolbar is not compatible with Microsoft Office 2013 or Microsoft Office 64 bit. CCH 
Coolbar is also not available if you are running Windows 8. 

 Make your selections and click Install to start Workstation Setup. 
 
6.  The Installing window displays.  
 
7. .NET Framework 3.5/4.0 will need to be installed with this release if not already installed. You may be 

prompted, depending on the workstation’s operating system, to confirm downloading of the files. If 
prompted, click Download and install this feature. The download may take several minutes. Otherwise, 
.NET Framework 3.5/4.0 will be automatically installed as part of the Workstation Setup. 

 Click Close when complete. There is no need to restart the install. The install will continue automatically. 
 
8. A progress bar shows that the workstation is being configured.  
 A message displays when Workstation Setup is complete. 
 Click Close to complete Workstation Setup.  
 Due to the installation of the .NET Framework 3.5/4.0, a reboot of the workstation may be required 

depending on the  workstation’s operating system. If prompted, complete steps to reboot the workstation. 
 Remember to run Workstation Setup on each workstation that uses ProSystem fx Practice Management. 
 
9. Now continue with Step 5 and update your database to the current version. 
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Step 5: Update your database to the current version 

1. Browse to your cpas\vpm\updates directory (on the server where ProSystem fx Practice Management was 
installed) and select Versiondb.exe to update your database. 
 

2. Select Update an existing Practice Management Database. 
 

 
 
3. Enter the following information: 
 SQL Server Name – The name of your Host Server defaults. Do not enter a path.  
 SQL DB Name – The database name defaults. Do not enter a path. Do not enter any special characters 

such as dashes, underscores, or periods. 
           Example: practicedata 

 
4. Click Continue to update your database to the latest version of ProSystem fx Practice Management. A 

message displays when the update completes. 
 
5. If you are licensed for CCH Coolbar, you must now update the CCH Coolbar database to the current 

version. If you are not licensed for CCH Coolbar, continue with Step 6: Verify your SQL backup routines. 
Note that CCH Coolbar is not available if you are running Windows 8. 

 
6. For the CCH Coolbar database update, open Versiondb.exe again and select File.  
 
7. Select CCH Coolbar Data Creator. Accept the existing defaults for your Practice Management database 

and click Next.  
 
8. Now select Update Active Practice Management Database (Default) and click Next. 
 
9. Click Process to build the CCH Coolbar database and populate it with updated data. A message displays 

when the update completes. 
 
10. Now continue to Step 6 and verify your SQL backup routines. 
 

Step 6: Verify your SQL backup routines 

Do you have a SQL add-on to your current backup software? 

• If the answer is Yes, refer to your backup documentation on how to back up a SQL database. 
• If the answer is No, contact your backup software provider for more information. 
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Downloading a Patch 

Please follow the instructions below to download a patch. 

1. Go to support.cch.com. 
2. Type Practice in Find a Product and then select the ProSystem fx Practice Management link. 
3. Select Updates.  
4. Select to Download the self-extracting file. Enter your firm’s ID and Password.  
5. You will be asked to either RUN or SAVE the update. We recommend saving the file to a temporary location rather than 

running it from the website. The temporary location must reside on a workstation that has Practice Management installed. You 
do not need to run this update from the server. 

6. Once saved, double-click the .exe file to initiate the update choosing the extraction location for the temporary setup files. 
7. You must run workstation setup on ALL workstations for this release to update required tools. 
8. ALL modules of Practice Management should be shut down, including the Tray (PMTray.exe), prior to the installation of 

any update whether or not workstation setup is required to ensure proper patching of the workstation. 
9. Now update your ProSystem fx Practice Management database to the new version. Run VersionDB.exe (from the 

…\cpas\vpm\Updates folder in your application directory). When the VersionDB window displays, select to update an 
existing Practice Management database. Enter your SQL server name and SQL database name, and click Continue. 

10. If you are licensed for CCH Coolbar, you must now update the CCH Coolbar database to the new version. For the CCH Coolbar 
database update, open Versiondb.exe again and select File. Select CCH Coolbar Data Creator. Accept the existing defaults 
for your Practice Management database and click Next.  Note that CCH Coolbar is not available if you are running Windows 8. 

11. Now select Update Active Practice Management Database (Default) and click Next. Click Process to build the CCH 
Coolbar database and populate it with updated data. A message displays when the update completes. 

 

Ordering Additional User Licenses 

Licenses for ProSystem fx Practice Management are part of the Permission Key.  Call your account service representative at 1-800-739-
9998 to place your order. 

 

Receiving Additional User Licenses 

1. On the support.cch.com website, go to Account Services/Firm Administration to log in and check your method of receiving 
updates. If you indicate email, you will receive notification that your licenses are ready. 

2. Once you receive the email notification, select Account Services. Then select Permission Key Download. 
3. Enter your firm’s User ID (Business ID) and Password. 
4. Download your new Permission Key with the additional licenses and extract the files to the ...\cpas\vpm\permkey folder. 
5. If you indicated to receive the Permission Key via diskette, you will receive a diskette in the mail. Copy the files to the 

...\cpas\vpm\permkey folder. 
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